Maretron

N2KBuilder®

NMEA 2000® Network
Design Software

User’s Manual

Revision 1.7.0

Copyright © 2011 Maretron, LLP All Rights Reserved

Maretron, LLP
9014 N. 23" Ave #10
Phoenix, AZ 85021-7850
http://www.maretron.com

Maretron Manual Part #: M002601

Revision 1.7.0 Page 1



N2KBuilder® User’'s Manual

7.10
8

9
9.1
9.2
10
11
12
13

Table of Contents

(oo 18 o 1 o 1SRRI 3
SyStemM REQUIFEMENTS ......eeiiieeeeece e e e e e e e e e 4
INStAlliNg N2KBUIAEI® .........oveeeeeeeeeeeeeee e, 4
UPAating N2KBUIAEE® ...ttt ettt ettt et 6
Starting N2KBUIAEI® ...ttt en e 7
SCIEEN LAYOUL ...ttt e e e e e e et e e e e e e 8
CompoNeNt LIDrary Ar€a .........oeeiuiiiiiiiiiiiiiiiiiiieeeeeeeeee ettt e et e e e eeeeeeeees 10
DeSIgN / Drawing AF€a.........uuuieeie et e e e e e 11
Lol (=1=T o 0o |1 o] I Y =Y TSP 11
Display Control AF€a..........ouuiiiiei et 11
Design Rule CheCk Area ...t 13
Tutorial 1 — Your First NetWOrK ... 14
Start N2KBuilder® and Populate the Drawing Area ..............ccooveveveeeeeeeeeeeeeee, 14
Add Detail to the Title BIOCK .......ccooo o 24
Add Detail t0 the DEVICES ......euuiiei et e e 24
Add Detail to the Cables........coooooiiiie 26
Design Rule Checks and Detail Display ... 28
Create Bill of Materials REPOrt............uiiiiiieieeece e 35
Create Design Rules Check RepoOrt...........oooviiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeee e 36
Create DeSigN REPOIT.........i e e e e e e e e e e e eeaneas 37
Create Network Configuration Table ... 38
Printing and Exporting the Drawings. .........ccoovoiiiii e 40
Tutorial 2 — Using the Single Ended Cordset................uuiiiiiiiiiiiiiiiiiiies 41
Tutorial 3 — More Complex Power OptioNS.........cccoooiiiiiiiiiiieeeeeeeeeeeee e 43
MUIIPIE POWET SOUIMCES ......uiiiieie ettt e e e et e e e e e e e e e e eeaa e e e eeees 43
Voltage Drops t0 the POWEITap......coouuuiiiiie e 48
Tutorial 4 — Extending an Existing Network ... 50
Tutorial 5 — Creating Other DEVICES ........covvvviieei e 57
Tutorial 6 — Working With PICIUIES ........coooeeiiieeeeeeeeeee 59
TECNNICAl SUPPOIT.....eeeeeeeeeee e e e e e e e e e e e e e s 62

Page 2 Revision 1.7.0
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1 Introduction

N2KBuilder® software is a powerful PC-based tool for designing and verifying the integrity of
NMEA 2000° networks. The N2KBuilder® software, when installed on a Windows PC and
used as part of an integrated design workflow can be used to layout, document, and validate
the design of complex NMEA 2000® networks. In addition, it will directly produce a Bill of
Materials (BOM) for Maretron products, eliminating guesswork and transcription errors.

Features:
e Pictorial display of all NMEA 2000° devices on the network
e Record a wealth of following information for each device:
0 Manufacturer (pre-programmed)
Manufacturer Model ID (pre-programmed)
Device Instance
Device Label
Manufacturer Serial Number
Installation Descriptions
Current requirements in Load Equivalent Number (LEN) and milliamps (pre-
programmed)

O O0O0O00O0

e For devices supporting multiple channels, the following information for each device may
be recorded, as appropriate:
o Hardware Channel
Indicator
Source
Instance
Label
Connected Probes

OO0O0OO0O0

e For devices with ancillary equipment attached, such as probes and cables, property
dialogs allow these to be recorded and included in the Bill of Materials (BOM).

e Produce a detailed drawing in either JPG or PNG format.

e Produce a detailed alphabetical Bill of Materials (BOM) with part numbers, descriptions
and quantities.

e Produce an N2K Design Rules Check Report to document network errors.

e Produce an N2K Design Report to document the design. This can be used in
discussions with clients to logically explain the devices on the Network.

e Produce a Network Configuration Table that can be used, in conjunction with
N2KAnalyzer® by installation and programming teams.

¢ Analyze the devices on the network to ensure that the network complies with the NMEA
2000° standard, and there are no voltage drops or cable lengths that may cause
devices to not function correctly.

e Update N2KBuilder® over the internet
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2 System Requirements

Personal Computer running Microsoft Windows 2000, XP, Vista, or Windows 7
1GB RAM

30 MB Hard Disk Space

Internet connection (Optional for Upgrades and Viewing Additional Information)

3 Installing N2KBuilder®

N2KBuilder® may be obtained free of charge.

Instructions for downloading N2KBuilder® will be sent to registered users only. To register,
complete the simple form on the web page

http://www.maretron.com/support/n2kb _downloadform.php and an email containing download
instructions will be sent to the address you supply.

Subject: Maretron N2KBuilder Download Instructions

Thank you for registering to download Maretron N2KBuilder™, Maretron's free tool for creating NMEA 2880° networks.
We are confident that you will find it a useful and powerful tool.

In order to install N2KBuilder, you must first install Adobe AIR. This provides the runtime environment that supports
N2KBuilder. You can download Adobe AIR from this link:

http://get.adobe.com/air/?promoid=BUIGQ

0Once you have installed Adobe AIR, please download N2KBuilder. To do this, please click the following link:

http://ww.maretron. com/support/n2kb download.php?id=3be6213fac27b8dc189953f14cb7bf5e4a68d179583f8

For more information on Maretron's broad line of marine instrumentation and vessel monitoring systems, please check
our website at

http://www.maretron.com

Since you've indicated interest in Maretron’s products by requesting a download link for N2KBuilder, we've added your
e-mail address to our mailing list for Maretron product information and updates. Should you wish to not receive any
further messages from us, simply click on the following link:

http://www.maretron.com/support/n2kb unsubscribe.php?email=alex.polmans@maretron.com

If you should have any questions about N2KBuilder or any of Maretron's products, please contact Maretron technical
support by any of the following methods:

E-mail: support@maretron.com

Telephone: +1 (682) 861-1787

Mail: Technical Support
Maretron, LLP

9014 N. 23rd Ave #18
Phoenix, AZ 85021

N2KBuilder® runs on Adobe® AIR™ technology from Adobe® Systems. Before installing
N2KBuilder® you must install Adobe® AIR™. Click on the first link in the email to download
and install Adobe® AIR™ and follow the instructions given.

Opening N2KBuilder.air ==

o —— After Adobe® AIR™ is installed, click on the second link to
Emr download and install N2KBuilder®.

which is a: Installer Package
from: http://www.maretron.com

it e o dowith il Click on OK to open the N2KBuilder® Installer Package with AIR.
e o0l ) The N2KBuilder® Installer Package is over 11Mbytes in size, so
the download could take some time.

Cancel
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When the Installer Package download is complete, the following Popup Window will be shown.

B} Application Install

Are you sure you want to install this
application to your computer?

Publishar: UNKNOWN . . . . .
Appiication:  W2KBuikder™ Click on Install to continue with the installation.

System Access: UNRESTRICTED

Install Cancel

Installing applications may present a security risk to you and
your computer. Install only from sources that you trust.

(®) Publisher Identity:  UNKNOWN
~  The publisher of this application cannot be determined.

@ soete

T Aot o =1

N2KBuilder™

Description

S sogs ek ader Select your installation preferences and location, and
Installation Preferences then Click On Con“nue_

I Add shortcut icon to my desktop

I Start application after installation

Installation Location:

C:\Program Filas

Continue Cancel

When the installation of N2KBuilder® is complete, it will start automatically.

If you selected to add a Shortcut icon to your desktop, you will see this icon
your desktop.

M2KBuilder
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4 Updating N2KBuilder®

To be updated requires that the computer running N2KBuilder® is connected to the Internet.

N2KBuilder® will periodically check Maretron®s website for the latest version. If a later version
is found on the server, then the following Popup Window will be displayed.

7 Updating: N2KBuilder [

™

Update available

An updated version of the application is available for dowmload.

rsion: 1.0.20000717.1

Download now Download later

} Release notes

" Updating: N2KBuilder =

™

Download progress...

Dovnloading update

» Release notes

> Updating: N2KRuilder =

Install update

The update for the application is dovnloaded and ready to be
installed.

™

1.0.20000717.1

Install now Postpene until restart

} Release notes

Click on Download Now, and a new version will be
downloaded from the Maretron® Server.

Having the latest version of N2KBuilder® installed
on your system will ensure that the components in
the Component Library Area are up to date with the
latest Maretron® catalog.

While the update is being downloaded, you can
view the Release Notes which give some
information about the changes from the previous
release.

When the download is complete, this Popup
Window will be displayed. Click on the Install Now
button to install the new version.

The previous version of N2KBuilder® will be
automatically closed, and the new version started
with the same file open.

While N2KBuilder® is running, you may also request that it checks for an update by clicking on

ok

Chec Check for Updates

s/ Go to Maretron Website
Ok

= Open User Manual

About M2KBuilder

the Check for Updates button under the About Menu.

Page 6
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5 Starting N2KBuilder®

You may start N2KBuilder® in one of four ways:

Selecting the All Programs— N2KBuilder® item from the Start Menu

Clicking the quick launch icon, if you requested one to be created during installation
Clicking the desktop icon, if you requested one to be created during installation
Clicking on a file with an extension of .n2b. The first time that you do this, Windows will
request that you assign this file type to N2KBuilder®.

The following disclaimer will be displayed when N2KBuilder® is started.

Warning

Maretron

N2KBuilder™ - NMEA 2000® Network Builder

Version 1.0.20090724

Disclaimer:

By pressing the "Accept" button, you acknowledge that while
Maretron products are designed to be accurate and reliable,
this software should only be used as an aid in the
development of NMEA 2000& networks and the software
should not be used as a replacement for traditional network
design and development technigues.

Accept Exit

You will need to Accept the disclaimer before continuing.

Pressing Exit will exit the program.
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6 Screen Layout
When you start N2KBuilder®, you will be presented with the following screen.

& N2KBuilder™ - New file =
e —— S

File Edit Tools About
Desiqn Rule Chech | Engine/Vessel Monitoring | Gateways/Tools | Adaptors{ Adapter Cables | Miscellaneous
X Terminatars / Mid/Micro Cable Components Displays/Alarms Navigation Instruments
Branches OK

X No Loops OK

I XNumber MNodes OK
X Cable Lengths OK
X Trunk Length OK
X Branch Length OK

X Cumulative Branch
Length OK

X Currents OK
X voltages oK

Commeon Mode
Vaoltages OK

Show On Drawing

Zoom In
Zoom Out

Display Details
Cable Lengths
Currents
Voltages

Plug Gender :
———— Maretron

Backbone(s) IKG e - NMER Z000F Restwor Gulder
| — - 307878

Wawian £.0.200

I St =
ot BT - 2008 Al Syutems Tosmeated M Rt

Harieied, RS Mosa and M AT an sk
st e cagtaed basamada It Lok St aegien
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The screen is divided into 5 areas.

=
& NZ2KBuilder™ - New file

File Edit Tools About

Desiqn Rule Check Engine/Vessel Monitoring | Gateways/Tools ] Adaptors/ Adapter Cables ] Miscellaneous
X Terminators / Mid /Micro Cable Components Displays/Alarms Navigation Instruments
Branches OK

’;'j::"gio“ Component Library Area =all

i = =
X Humber Nodes OK i =

Design Rule
Check Area

# Cangth ok 7
XCurrents oK
X voltages oK

X Common Mode
Voltages OK

Show On Drawing

S I

I
Screen Control

Irea Design / Drawing Area

Display Details
Cable Lengths
Display Control

Area
Plug Gender p—
how Handles Maretron
Backbone(s) MIXEuddar™ - RMEA TU00T Network Bulder

wian £330
2w Date:
N I Comrigrt £ 000 Maratn LLF. Adooal A5
Checkee Date: Comirgnt 2007 - 2008 Adooe Sytama Frcrrabad. M Rt
rzzeauad: s Faanl, (@A, Msiel 0 Aol A aw atee
o mgatad Eadearka b b Unkad e andir
Fmvizicn: Date:
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6.1 Component Library Area

This is a set of tabbed pages containing the components and cables that can be dragged into

the Drawing Area.
Engine/Vessel Monitoring Gateways,/Tools Adaptors/Adapter Cables Miscellansous

Mid f Micro Cable Components Displays/ Alarms

Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables Miscellaneous

Engine/Vessal Monitoring Gateways/Tools Adaptors/Adapter Cables Misceallaneous

Mini Cable Components Mid / Micro Cable Components HNavigation Instruments

nnnnn

The DSM200 has been given faded colors to show that it has been discontinued and will never
be placed on the BOM.

Engine/Vessel Monitoring Gateways/Tools Adaptors/ Adapter Cables Miscellaneous

Mini Cable Components Mid / Micro Cable Components Displays/Alarms

S — DSTIERD
$5C200 - 7
== =

PGPS100 WP GPS200) mi =

The GPS100 and DST100 have been given faded colors to show that they have been
discontinued and will never be placed on the Bill of Materials (BOM).

Mini Cable Components Mid / Micro Cable Components Displays/Alarms Navigation Instruments
Gateways/Tools Adaptors/Adapter Cables Miscellaneous

= TLA100 - . * . . e . . . . TLM100 §ES TLM150 §FS TLM200 |

EMS100 MCM100(HRDCM100|HRSIM100 [HRRIM100 (N THMPLOO|H FPM100|{
. L 10'] | -. - - - . - - - - - - -
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Mini Cable Components Mid / Micro Cable Components Displays/Alarms HNavigation Instruments
Engine/Vessal Monitoring Adaptors/Adapter Cables Misceallaneous

use1oo | 12k100 [jl§ | IPG100 |p

Mini Cable Components Mid / Micro Cable Components Displays/fAlarms Navigation Instruments

Engine/Vessel Monitoring Gateways/Tools Miscellaneous
= - =

AT 1|JE Simnef

(uf33ﬁ gﬁlsi;%@
Cable

O i

i
The AT10 and Simrad Adapter Cable have been given faded colors to show that they have
been discontinued and will never be placed on the BOM.

Mini Cable Components Mid f Micro Cable Components Displays/Alarms Navigation Instruments

Maretron

6.2 Design / Drawing Area

This is the main drawing area where you do all the work. Initially the screen is sized at about
900 x 500 pixels, but it may be extended by zooming out to 10000 x 10000 pixels. If the
Drawing Area is too big to be displayed, then scroll bars will be displayed to allow the visible
area to be moved. Alternatively, right clicking on the grey background of the Drawing Area, and
then moving the mouse with the right button held down will also move the drawing.

6.3 Screen Control Area

These buttons control the zoom level of the Drawing Area. Zoom In will
| Zoom In | increase the zoom level by 50%; Zoom Out will decrease the zoom level
by 50%; and Zoom Extents will zoom the design so that all the
components are visible.

Display petas | 0.4 Display Control Area
| cableLengths | These buttons control the amount of information displayed on the screen.

The Cable Lengths, Currents, and Voltages buttons display the cable
| Voltages | lengths, currents and voltages next to the components and cables as
appropriate. Only one of these may be displayed at a time.

Page 11
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The Plug Gender button displays the plug gender of the components. The
display of the gender is toggled on and off by clicking on this button.

3

After creating a line or a cable, the handles or junctions (i.e., where the
cable or line changes direction) may be moved by dragging handles
displayed at the cable junctions. The Show Handles button controls
whether these handles are displayed or not. If the handles are not
displayed, then the cable junctions may not be moved.

If there are sufficient components connected
correctly in the drawing to identify the
backbone(s) or trunk(s) of the network, the
backbone may be identified on the drawing by
a green overlay. To correctly identify a
backbone, N2KBuilder® requires at least two
terminators to be connected via cables and other components. If there are errors in the
backbone (e.g. three terminators) then the overlay will be red. If there is no power to the
backbone, the overlay will be yellow. Clicking on the Backbone(s) button will toggle the
display of the colored overlay.

Page 12 Revision 1.7.0
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6.5 Design Rule Check Area

N2KBuilder® continually evaluates the design against a number of rules determined by the
NMEA 2000® standard. These rules are:

Design Rule Checks

= I

H,r Terminators |
Branches OK

o Backbone OK
if No Loops OK

o Power OK

o Mumber Nodes OK
o Cable Lengths OK
o Trunk Length OK

o Branch Length OK

Cumulative Branch

v Length Ok

o Currents OK

o Voltages OK
Common Maode
Voltages OK

4 All Devices
Connected

Two and only two terminators per network backbone.
Backbone passes through no multiport boxes (warning only)
No loops.

Power supplied between 9V and 16V in sufficient places to
power all the components.

Not more than 50 nodes without appropriate repeaters.

Mini Backbone length less than 200m.

Mid/Micro Backbone length less than 100m.

All cables have been assigned a length.

Branch lengths must not exceed 6m.

Cumulative branch length must not exceed 78m.

Currents through each cable and cable component (i.e., tee,
bulkhead feedthru, multiport box, etc) must be within their rating.
Supply Voltage at each device must be between 9V and 16V.
Common Mode Voltage at each device must be less than 2.5V.
All devices are connected to the backbone (warning only)

Revision 1.7.0
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7 Tutorial 1 - Your First Network

The first network will be a simple navigation system for a small yacht. It will consist of the
following devices, connected using Micro Cables.

e DSM250 Color Display

e WSO100 Wind/Weather Station

e SSC200 Solid State Rate/Gyro Compass

e GPS200 GPS Antenna/Receiver.

7.1 Start N2KBuilder® and Populate the Drawing Area

The initial screen will have a Title Block in the bottom right corner. We will populate this later.

Start populating the Display Area by placing a DSM250. The DSM250 is in the
Displays/Alarms tab in the Component Library Area.

Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables Miscellaneous

Mini Cable Components Mid / Micro Cable Components Navigation Instruments

Select the DSM250 by clicking on the symbol. Note that hovering over the symbol will display a
tool tip showing the description of the device, so if you are ever unsure of what a device is ...
just hover over it. When the device has been selected, a black glow will be shown around it.

Engine/Vessal Monitoring Gateways/Tools Adaptorsf Adapter Cables Miscellansous

Mini Cable Components Mid / Micro Cable Components Navigation Instruments

Multi-Function Coler Display

Now move the cursor into the Drawing Area using the mouse. The DSM250 will follow. Press
the left mouse button to drop the device onto the Drawing Area.

Page 14 Revision 1.7.0
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Maretron N2KBuilder™ ‘“‘

File Edit Tools About

===

Desiqn Rule Checks Engine [Vessel Monitoring Gateways/Tools Adaptors/ Adapter Cables Miscellaneous
X Terminators / Mini Cable Components Mid / Micro Cable Compenents. Navigation Instruments
Branches OK
Backbone OK o
X Mo Loops OK W DSMBOQ MBBI{ RO
X Power 0K
== =

X Number Nodes OK

X Cable Lengths OK
X Trunk Length oK

X Branch Length OK

¢ Cumulative Branch
Length OK

X voltages ok

xCDmmon Mode

Voltages OK
All Devices
Connected

Show On Drawing

Zoom In
Zoom Out
Zoom Extents

Display Details

Cable Lengths
Currents
Voltages

Plug Gender

Show Handles
— Maretron

NIKE e - KR TH00T Naterarh Sulder
Ve 1730220238

R St 8 i LS. el K
om0 S0 A Spatama sl 4 St

Facato, (DR, sl as el AR ae s
Sz o i B s

BLR|E R

Notice that there is still a DSM250 following the cursor. This enables you drop another
component of the same type very quickly without having to go back to the Component Library
again. Drop a second DSM250 onto the Drawing Area.

To free the cursor from the device, do one of the following:
e Click on the same component in the Component Library
¢ Click on the background of the Component Library

¢ Right Click with the Mouse to bring up a menu, and then click on Cancel with the left
button

e Press the Escape (Esc) key

The following screen shows the screen after dropping 2 DSM250s on the drawing area and
then right-clicking to bring up the component menu on the DSM250 that we are dragging
around.
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Maretron N2KBuilder™

~——

-_—

File Edit Tools About

Design Rule Checks Engine/Vessel Monitoring
J¢ Termina tors / Mini Cable Components
Branches OK
Backbone OK
X o Loops OK
X Power OK

X Humber Nodes OK

Gateways/Taols

Mid / Micro Cable Components

DSMB00) BB D

Adaptors/Adapter Cables Miscellaneous

Navigation Instruments

X Cable Lengths OK
X Trunk Length OK

X Branch Length OK

x Cumulativa Branch
Length OK

X currents oK
X voltages oK

xCommon Moda

Voltages OK
All Devices
Connected

Show On Drawing

Zoom In
Zoom Qut
Zoom Extents

Display Details

Cable Lengths
Currents
Voltages

Plug Gender
Show Handles
Backbone(s)

DSM250

Flip Vertical
Cancel

Maretron

NIKG e - WA T000T mtwark Dulder
sasaz

Vamon £.7.301.

BolR R R

Free the cursor so that nothing is following it. We now have two DSM250s on the Drawing
Area, which is one too many. Left click on the rightmost DSM250 to select it (notice the black
glow around the DSM250 which shows that it has been selected) and then right click to show
the component menu.

The component must be selected to respond to the right click.

There are a couple of things that we can do
here, but we will get to them later. For now,
click Delete to remove the device from the
Drawing Area.

Flip Vertical
Exclude from BOM

Delate

You could also press the Delete button on your
keyboard.

Properties
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Get the rest of the components in the same way. Select the Navigation Instruments tab in the
Component Library Area, and then drag a WS0O100, SSC200, and GPS200 onto the Drawing
Area. We are going to put the WSO100 on top of the mast and the GPS200 on the cabin top.

| =)

Maretron N2KBuilder™
File Edit Tools About

Desiqn Rule Checks Engine/Vessel Monitoring | Gateways/Tools | Adaptors/ Adapter Cables ] Miscellaneous

X Terminators / Mini Cable Components Mid / Micro Cable Components Displays/Alarms
Branches OK

Backbone OK

X No Loops OK DS TS
X Power 0K

X Number Nodes OK

X Cable Lengths OK

X Trunk Length oK

X Branch Length OK
J Cumulative Branch
Langth OK

X Curren ts OK

X voltages ok
Common Mods (EPS200
Voltages OK C—— 1
All Devices __/
Connected

Show On Drawing

Zoom In
Zoom Out
Zoom Extents

Display Details

Cable Lengths
Currents
Voltages

Plug Gender

Show Handles .
— Maretron

NTE e - WMER TO0DT Natwwork Bulder
amien £7.308£8138

Pl Dot 000 i LS. dssel A
ot £ I007 - 00 e Sasame Tocormeribad M Dt

Hanieso®, (R Mt and Mssal S ane s
Eatarata s et Sademais s e Lokt Sabas et
.......
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Next add the PowerTap so that we can get power to the network. We are going to use Micro
cabling, so choose the Micro/Mid Power Tap Tee from the Mid/Micro Cable Components tab in

the Component Library.

Engine/Vessel Monitoring l Gateways/Tools l Adaptors{Adapter Cables Miscellaneous
Navigation Instruments

Mini Cable Components Displays/Alarms

rEPS200Y
1
SSC200
Titha:
U] Maretron
T - tEA 25 Pk e
—T
I i
FaMEuder™. Coyignt © 2000 Maretron LLP. Adcal AR
Chdeca: Sane: ot ) 207 - 2008 Atoaa Sywbaa: Tossemsrabad M Rt
Approved: Jane: el RRAde ™, ke and Adsel AT aow ek
v e
i
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To terminate the network, we will use a Micro Termination Resistor Male near the DSM250,
and a Micro Inline Termination Resistor connected to the WSO100. Both of these can be found
in the Mid/Micro Cable Components tab of the Components Library Area.

Remember that you can hover over a component to identify it.

Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables
Mini Cable Components

Miscellaneous

Displays/Alarms Navigation Instruments

EIIIJ
Ws0100/

Maretron

- mMEs 7000T
Wawion £.7.20880828

A St R Mk LS. ksl A
Checked: Date: ot 2007 - 2008 Adok Syatama Tetomeated 4 i

acatep, FRAN, ke and Al A5 4 e
RS-
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Now we will turn the Micro Inline Termination Resistor around and

ﬁ: connect it to the WSO100. Left click on the Micro
m Inline Termination Resistor to select it, and right
click to display the associated menu. The (I
1 WSO100 has a male connector; the Micro Inline =
fotate Anticlockuion Termination Resistor has a female connector on
Flip Horizontal the left, so click on Rotate Clockwise to get @
Flip Vertical these connectors oriented towards each other.

Exclude fram BOM
Dalate

To make the connection, move the Micro Inline Termination Resistor by grabbing it with the
mouse and moving it until the plugs line up. (Hold the left mouse button down while moving the
mouse, and then release the mouse button).

Notice the Warning that pops up.
war % N2KBuilder™ is not designed to draw a physical
representation of your network. While it will ensure that

Maretl'on the connector genders are correct, it will not take into

account any keying of the connectors.

N2KBuilder™ - NMEA 2000® Network Builder

et Do the ey of cometores ey mot For example, N2KBuilder™ will allow
et el pl2ce the compananis in this you to connect 2 Mini Tees together in ﬂ‘%[ﬂ]%[ﬁ
the following manner.

|| Do not show this Warning again.

While this is logically correct, it is not
physically possible, and the Tees will

__o | actually be joined as shown in the %

second diagram.

This will make the layout of your drawing easier, but will not guarantee that the layout of your
drawing matches the physical installation

Now, back to our design ... we should have just made the connection between the in-line
terminator and the WSO100.
If you were close, the Micro Inline Termination Resistor will snap into place, and

the components are connected.

Deselect the Micro Inline Termination Resistor by clicking on the background.
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Drag three Micro Tees from the Mid/Micro Cable Components tab onto the Drawing Area.
Before placing the first Tee just below the DSM250, right click the mouse, and select the Flip
Vertical menu option to correctly orient the Tee (male connector on Tee always points towards
Powertap). Before placing the second Tee below the SSC200, right click the mouse and select
the Flip Horizontal menu option to correctly orient the Tee so that the male connector of the
Tee faces the female connector of the Power Tap Tee. Connect the first Tee to the Micro
Termination Resistor Male by moving either the Tee or the Terminator until the plugs line up.

Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables | Miscellaneous |

Mini Cable Components Displays/Alarms Navigation Instruments

s "f' i Maretron

- RMEA 2000F Rewtwark Builder
Wawien £7.20820825

P Coopigt ) 2003, Marateon LS. Adcoalp AR
ekt Dat=: s 37 - 200 Adse Syatema Tosaed MR

Agprocd : ER — U
satamaca o Lot St gt
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Last, we will add the cables. Micro connectors can have either Micro or Mid size cabling,
shown in N2KBuilder® by different thicknesses. Hovering over the cable will also show the
thickness. Cables may also be bought with the connectors attached (Double Ended Cordsets)
or built from Bulk cable with field attachable connectors.

Click on the Micro Double Ended Cordset, which is at the top left of the Mid/Micro Components
tab. Now when the mouse is moved into the Drawing Area, there is a
small connector that follows the mouse cursor. Move the cursor near the
plugs on a Tee. Notice that the connector will change orientation and

Eﬂ]m gender to match the nearest plug. Move to the rightmost male
connector of the Tee under the DSM250, and when the cable connector
changes to the correct orientation, left click the mouse to connect the
first end of the cable to the Tee.

A second connector, of the opposite gender to the first end of the cable
is now displayed. Move this until it is lined up with the leftmost connector
on the power tap, and make this connection as well.

Repeat this process for all the cables.

If necessary move the components around to neaten up the drawing.

Maretron

ldur™ - NMER Z000F: Netwark Suilder
Wamian £7.108 80825
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Congratulations — you now have your first network in place. Save it by selecting File > Save
As and entering a filename in the Save As Dialog. The file extension will be set to .n2b.
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7.2 Add Detall to the Title Block

Left click on the title block to select it, and then right click to open the title block menu.

A - 8 Froperties

wenlion §.0. 0090733

R, Cxmiht B DU ek LLP. kel A3

Maretfrnn

Delete

Cooyright I 2007 - 2008 Adooe Svatems Incomorsbed. Al Rights

Farstron®. KaEulder™, Adaal and Adcal AR are sbar
EacdwTaria o ragbered tademarka it Unbed Sk and'or

Click on Properties to open the
Properties Dialog for the Title Block.

In this case, the Title Block Properties

Dialog is a replica of the Title Block itself, and it gives us the opportunity to enter some values.

Title Block Properties

Title:

Maretron

N2KBuilder™ - NMEA 2000® Network Builder

X

7.3 Add Detail to the Devices

Left click on the SSC200 to select it, and then right click to open the device menu. Then left
click on the Properties option to open the Properties Dialog. Each device has a different
Properties Dialog; the SSC200 being one of the simplest.

S5C200 Properties
Device Instance
Device Labal
Serial Mumber
Installation Description 1

Installation Description 2

More Information

x

Enter a Title of Tutorial 1.

Add your name to the Drawn box, and
select today’s date for the Drawn Date.

Press the OK button to save these
values.

These six fields can be found within all
device Property Dialogs, and they are
informational only at this point. By filling
in all the fields early in the design phase,
you will create a record that can be used

. later during installation.

If you are connected to the Internet, clicking on the More Information button will use your
default Internet Browser to open a web page showing the full specification of the Device.
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Open the Property Dialog for the DSM250 — this is a little more interesting.

DSM250 Properties =

Device Instance a E

Diavice Label

Serial Numbar

Installation Description 1

Installation Description 2
Len 1z Current 650mA

The DSM250 may be ordered in different colors.

Caolor Black v
Number of optional packs of 2 Covers 0 Ij f
. Number of optional Gimbal Mounts o Ij
More Information | OK | | Cancel |
f—— .

As well as the standard 6 fields for Device Instance, Device Label, Serial Number, Installation
Descriptions and the Current Drawn, we also show some options that will affect the Bill of
Materials. Change the color to White, and include a Gimbal Mount or extra covers before
selecting the OK button.

DSM250 Properties x

Device Instance o =

Davica Labal

Sarial Number

Installation Description 1

Installation Description 2

Len 13 Current 650mA

The DSMZ50 may be ordered in differaent colors.

Color White -
|
Number of optional packs of 2 Covers 0 Ij
| Mumber of optional Gimbal Mounts 1 Ij
More Information | OK J L Cancel |
— "

Notice that when you get back to your drawing the color of the DSM250 has changed to white.
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7.4 Add Detail to the Cables

Adding detail to the cables is essential to the design verification process. Without accurate
input on how long the cables are, it is impossible to calculate voltage drops.

Right click on the cable running to the WSO100, and select the Properties option. The
following Cable Properties Dialog is displayed.

Cable Properties
Cable Name :

(+) Doubls Ended Cordset () Single Ended Cordset () Field Attachsble Cable

() Mid (=) Micro

(_) Blue (s) Grey

Cable Length in m | undefined | v

Cable Resistance omQ

Close

Assume the distance up the mast is 18m. Prebuilt double ended cordsets are limited to 10m,
and are therefore not suitable for this design. We need to buy 18m of bulk cable, and then
connect a field attachable connector to each end.

To achieve this, change the cable type to a “Field Attachable Cable”. More options will be
displayed.

Cable Properties Type 18 in the Cable Length field.

(_) Double Endad Cordset () Single Ended Cordset (s) Field Attachabla Cabla TO he|p yOU understand the properties Of the

O i O wid (@) ero cable that you have just created, N2KBuilder® will
calculate the resistance of one of the power wires
in the cable and display it. This resistance also
includes the internal contact resistance of the

() Blue (s Grey

Cable Length inm | 18
Cable Resistance 1063mQ

[] Male connector has 500 bend

[ Eresk pover cable st Male Connector connectors.

L Female connector has 90% bend !

[ Eresk pover cable at Female Connector ' Set the cable name to “Mast-Cabin”. Normally you
 Glose | will choose a name that will identify the cable to

the installers, and mark both ends of the cable
with the same name.

Close the Properties Dialog.

Notice that the drawing has changed to show the Field attachable connectors.
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Not all Cables are Created Equal

NMEA 2000° is a high speed data bus, similar to Ethernet.
At these speeds, the signals do not travel cleanly from one
end of the cable to the other, but are subject to many
reflections from each connector, branch and cable join.
These reflections cause the signal to degrade significantly,
and at some point the network fails to work.

NMEA have established a set of requirements for NMEA
2000° networks which, when followed, will ensure that the
signals remain strong enough for the messages to get
through. Some of these requirements limit cable lengths
and the number of nodes, and N2KBuilder® will evaluate
your design to check that these requirements are met.
Other requirements dictate the physical characteristics of
the cabling and connectors to ensure clean signals.

N2KBuilder® assumes that only NMEA2000® approved
cabling will be used on the network. Use of cabling that
does not meet NMEA 2000° requirements will result in
weaker signals and lower voltages than expected and will
invalidate all the calculations and Design Rule Checks.

It is essential that only NMEA2000® approved cabling and
connectors are used in building NMEA2000° networks.
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7.5 Design Rule Checks and Detail Display

Design Rule checks At this point, take a look at the top left of the screen, in the Design Rule
S/ Terminators / Checks Area, to see how compliant our network is to NMEA 2000°

Branches OK . .
/ Backbone OK requirements. We seem to be doing very well.

¥ o Loops OK The number of terminators correctly checks OK

The backbone does not contain any multiport boxes

The No Loops correctly checks OK

The Power feed correctly checks OK

The Number of Nodes or devices correctly checks OK

J Branch Length OK There ARE undefined cable lengths — that’s expected — we have

/ Cumnulative Branch only entered the detail for one cable.
Length Ok

o Power OK
o Mumber Nodes OK
XCahle Lengths OK

o Trunk Length OK

o/ Currents OK e The trunk length correctly checks OK
e The branch lengths report OK.
";‘;”'tage; c:: ; e The cumulative branch length reports OK.
Voltages OK e The currents, voltages and common mode voltages report OK.
v Al Devices e All devices are connected to the bus.

| Show On Drawing |

Click on the Show On Drawing button so that we can see, on the drawing, which Cable
Lengths are not OK.
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Noreton NoBuider™ e e L ] = ]

File Edit Tools About

Desian Rule Checks Engine/Vessal Monitoring | Gateways/Tools | Adaptors/ Adapter Cables Miscellaneous

J Termina tors / Mini Cable Components Displays/Alarms Navigation Instruments
Branches OK

' Backbone OK
W Mo Loops OK

 Power 0K
 Number Nodes OK

X Cable Lengths OK
 Trunk Length OK

 Branch Length Ok

/ Cumulstive Branch
Length OK

Zoom In
Zoom Out
Zoom Extents

Display Details

Cable Lengths
|| Currents
Voltages

Plug Gender
| Show Handles
Backbone(s)

Maretron

IR lder - NMER T000T Matwork Bulder
Vwien 1330822838

-

Erdamatia s gt st e b Bakas 2

The cable lengths that are not defined are highlighted in red.
Remove the display of the Design Rule Checks Errors by clicking on the Show On Drawing
button again, and then, using the Cable Properties Dialog, set the lengths of the cables as
follows:

e On the left of the Micro Power Tap Tee : 40m (make this a Field Attachable Cable)
On the drop to the DSM250 : 1m
On the right of the Micro Power Tap Tee : 10m
On the drop to the SSC200 : 5m
On the drop to the GPS200 : 7m
Between the last two Tees : 10m

Display the cable lengths on the drawing by clicking on the Cable Lengths button. To neaten
up the drawing you may need to drag the labels to better places.

Revision 1.7.0 Page 29



N2KBuilder® User’'s Manual

Maretron N2KBuilder™

“—%

File Edit Tools About

Design Rule Chacks

J Termina tors /
Branches OK

" Backbone OK

& Mo Loops oK

 Power OK

 Mumber Nodes OK

Engine/Vessel Monitoring
Mini Cable Components
PGrs100Y

—
-
=

Gateways/Tools
Mid / Micro Cable Components

= =
- =
DSI'.I? DSTB

Adaptors/ Adapter Cables
Displays/Alarms

 Cable Lengths oK
 Trunk Length OK
X Branch Length OK

.[ Cumulativa Branch
Length OK

' Currents oK

X voltages oK

g Common Moda

Voltages OK
All Devices
Connected

Show On Drawing

Zoom In
Zoom Qut
Zoom Extents

Display Details

Currents
Voltages

Plug Gender
I Show Handles
Backbone(s)

Maretron

BLE[ R

IR ulder - NMIZA TO00T Matework Sulder
[

In the Design Rules Checks Area, we can see that we now have the Cable Lengths OK, but

have introduced errors in the Branch Lengths and Voltages. Press the Show On Drawing
button to highlight the problems.

The 7m long cable to the GPS200 is the cause of the Branch Length problem, so reduce its
length to 6m, which is the maximum allowed length for a drop.
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This leaves the voltage problem. Display the voltages by selecting the Voltages button.

Maretron N2KBuilder™

File Edit Tools About

Design Rule Checks

J Terminatars !
Branches OK

' Backbone OK

W Mo Loops OK
 Power 0K
 Number Nodes OK

Engine/Vessel Monitoring

Mini Cable Components

Mid / Micro Cable Components

Gateways/Tools Adaptors/Adapter Cables Miscellaneous

Displays/Alarms

/ Cable Lengths OK
 Trunk Length OK

 Branch Length Ok

/ Cumulstive Branch
Length OK

X voltages ok
v Commaon Mode

Show On Drawing

Zoom In
Zoom Out
Zoom Extents

Display Details

Cable Lengths
Currents
Voltages

Plug Gender
Show Handles
Backbone(s)

12Wolts

10.8Volts I

11.05Volts

11.24Volts

Maretron

IR lder - NMER T000T Matwork Bulder
Vwien 1330822838

oz 2000

N o Lz e x5
otz 2007 - 2008 A,

Srematas 4 s

Faase b
atamads s

LR LR [B

e 4 e A e s
st it ot St g

You can also use the mouse to hover over the selected component and get error information.

Multi-Function Color Display
Supply Voltage 8,66V is too low

Snap
Network Functions b
Exclude from BOM

Change Cable Colors to Blue
Change Cable Size to Mid

Delete

Properties

The cables are too thin to supply enough power to the
DSM250 at the end of the backbone. This is probably a good
time to decide to upgrade the entire network to use Mid
cables instead of Micro cables. We could change each cable
using the cable Properties Dialog, but there is an easier way
using the Network Functions of N2KBuilder®. Right click on
any cable in the backbone, and select the Network
Functions option.

The choices given under the Network Functions depend on
what changes can be made to the cable selected. We want
to change the Cable Size to Mid, and that is available. Click
on it.

All the cables in the drawing change to Mid, and the voltage at the DSM250 rises to 11.1V.
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Notice also that the cable thicknesses have changed in the drawing area to reflect this change
to the cables.

Try changing the cable colors to Blue.

Note also that all the Design Rule Checks have now passed.

[ ' N2KBuilder™ - tutorial 1.n2b As a final clean up, select the Tools Menu from

File Edit [Tools| About the top list of menus, and then select Snap all
Design Ri Create Bill Of Materials Report Cables / Lines.

Termin Create Design Rules Check Report L. .

Branchy : Individual cables can be snapped into 90
(N L Create Design Report . R

o mae N degree angles by right clicking on the cable
e Create Metwork Configuration Table : .
L and selecting the Snap option.

o Numbe Include All Within in BOM
+ Cabla | Exclude All From BOM
« Trunk | Snap all Cables / Lines

_f Or—mrb | AnArR A ]

The cables also have handles at their intermediate points which can be dragged
to reposition the intermediate points of the cables. To display the handles, click
on the Cable Handles button on the left of the screen. To hide them, click on the
Cable Handles button a second time.

To display the gender of the connectors — this is important for the installer — click on the Plug
Gender button at the left of the screen.
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Maretron N2KBuilder™

=T X

File Edit Tools About

Design Rule Checks

J Terminatars !
Branches OK

' Backbone OK

W Mo Loops OK
 Power 0K
 Number Nodes OK

Engine/Vessel Monitoring Gateways/Tools

Mini Cable Components

=z

Mid / Micro Cable Compo:

§

T
W s&zoo

Adaptors/Adapter Cables

nents

D STIQ

Displays/Alarms

Miscellaneous

/ Cable Lengths OK
 Trunk Length OK

 Branch Length Ok

/ Cumulstive Branch
Length OK

 Voltages oK

Comman Mode
Voltages OK
All Devices
Connected

Show On Drawing

Zoom In
Zoom Out
Zoom Extents

Display Details

Currents

Voltages

Backbone(s)

i

DSM250 =,
. ot [F T M M
F F
im I 5m e
M M
r Fn 2w 10m .%.
LEGIGECING ] GO G U GO R G ]

5m

SQi0

HEIG]

Tithe

Tutorial 1

Maretron

LR LR [B

Click on the Plug Gender button a second time to remove the display of the genders.

To make the drawing more readable, add Lines and Text from the Miscellaneous Tab. When
placing a Line on the Drawing Area, select the line in the Component Library and then click in
the Drawing Area where the start of the line should be dropped. Continue clicking to drop the
mid points of the line, and then click twice at the same point to drop the end of the Line.
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7.0

Page 33



N2KBuilder® User’'s Manual

Maretron N2KBuilde:

File Edit Tools About

i Cable Components Mid/Micro Cable Components

Design Rule Checks

 Terminators !
Branches OK

" Backbone OK

Engine/Vessel Monitoring Gateways/Tools

& Mo Loops oK
 Power OK

Displays/Alarms

Adaptors/Adapter Cables

Navigation Instruments

 Mumber Nodes OK
 Cable Lengths oK
 Trunk Length OK

 Branch Length OK

.[ Cumulativa Branch
Length OK

' Currents oK

 Voltages OK

g Common Moda

Voltages OK
All Devices
Connected

Show On Drawing

Zoom In
Zoom Qut
Zoom Extents

Display Details

Currents
Voltages

Plug Gender
Show Handles

Backbone(s)

Cabin

Tithe:

Tutorial 1

Maretron

oufzrizaLL

-

Emmemund
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7.6 Create Bill of Materials Report

The Bill of Materials (BOM) Report is generated from the Tools Menu.

j MNZKBuilder™ - tutonal 1.n2b

File Edit

Design Ry
Termin
Branchi

‘, No Loo
quwer{
(Numbe
« Cable L

(Trunk L

« Branch Length OK |

Tools | About

Create Bill Of Materials Report
Create Design Rules Check Report
Create Design Report

Create Metwork Configuration Table
Include All Within in BOM
Exclude All From BOM

Snap all Cables / Lines

Selecting Create Bill of Materials Report will bring up the following screen, which can be:
e Exported as a comma separated value (csv) file for importing into Excel or another

program,

e Exported as a pdf file,

e Printed.

Bill of Material Report

Maretron components are distributed through autherized dealers anly. For the dealer closest to you please visit the

Maretron website.

Manufacturer
Maratron
Maratran
Maratron
Maretron
Maretron
Maretron
Maratron
Maratron
Maratron
Maratron
Maratron
Maratron
Maratron
Maratron

Maratron

| Create CSV File | Create PDF File I

Part Number
CF-SPWR.05-CF
CM-CF-CF

DB1
DM-DB1-DF-01.0
CM-DBE1-DF-05.0
DM-DB1-DF-06.0
DM-DBEL-DF-10.0
DSMZ250-02
DSMMNTASSELY
FA-CF-5T
FA-CM-5T
GP3200-01
IT-CM-CF
S5Cz200-01

TR-CM

Description

Micro/Mid Sm Power Tap Tese

Micro Tee

Mid Bulk Cable Blue {per mater) (no spool)

Mid Double Ended Cordset - M to F - 1.0m Blue

Mid Double Ended Cordset - M to F - 5.0m Blue

Mid Double Ended Cordset - M to F - 6.0m Blue

Mid Double Ended Cordset - M to F - 10.0m Blue
High Bright Color Display (White Enclasure)
DSMZ00/DSM250 Gimbal Mount

Micro/Mid Field Attachable Connector (straight female)
Micra/Mid Field Attachable Connector (straight male)
GP3/WAAS Antenna/Receivar

Micra Inline Terminatar

Solid State Compass

Micro Termination Resistor Male

Print J

Notice the following about the entries in the BOM.

Quantity
1 "
3

58

Close
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e The two bulk cables have been combined into one length of 58m. Should this length go
over 100m, then a spool of 100m will be ordered, plus the additional cable as a
separate piece.

e The gimbal mount has been included for the DSM250

e The DSM250 has been ordered in a white enclosure.

e 4 field attachable connectors have been included for the bulk cable.

7.7 Create Design Rules Check Report

Select Tools - Create Design Rules Check Report to display a textual report showing what
the problems are with the network.

Design Rule Check Report =

Design Rule Check Report for C:\Users\alex.polmans'\Desktop\n2kBuilder files\tutorial 1.n2b

This file contains 1 network.
1. Network 1
Backbone contains only blue cables.

Backbone contains no errors.

Create PDF File | | Close |

The Design Rules Check Report may be exported as a PDF file. From there it may be printed
or emailed.
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7.8 Create Design Report

Select Tools > Create Design Report to display a textual report showing details of each
branch in the network.

Design Report b4

DESIGM REPORT for Ci\WUsers\alex.polmans\Desktop\n2kBuilder files\tutorial 1.n2b &
This file contains 1 network.
1. Network 1
Backbone contains only blue cables.

1. Attributes

Number of Devices = 4.,

Backbone length = 58m.

Cumulative Branch Length = 12m.
2. Branches

1. Branch 1 to Maretron DSM250.

Device is a Multi-Function Color Display manufactured by Maretron.

Len = 13 (650mA). r

Branch length = 1m.

Supply Voltage at DSM250 = 11.48V.

Common Mode Voltage at DSM250 = 0.26\.

2. Branch 2 to Maretron SSC200.

Device is a Solid State Compass manufactured by Maretron. |

Len = 3 (150mA).

Branch length = 5m. A

Supply Voltage at S5C200 = 11.5V. -
Create PDF File Close

The Design Report may be exported as a PDF file. From there it may be printed or emailed.
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7.9 Create Network Configuration Table

The Network Configuration Table is used by installers to set up the devices on the Network.
The information in the table is obtained from the detail entered in Device Property Dialogs.

Start with the DSM250. Select it; display the menu by right clicking, and the open the Property

Dialog.

DSM250 Properties

Device Instance

Device Label

Serial Number
Installation Description 1

Installation Description 2

.
M |

Helm

516653GH

Cockpit

At the helm

Len 12 Current 850mA

The DSM250 may be ordered in different colors.

Colar

Number of optional packs of 2 Cavers 0

Number of optional Gimbal Mounts 1

| More Information |

S55C200 Properties

Device Instance

Device Labal

Serial Mumber
Installation Description 1

Installation Description 2

white L4

(60

x

| cancal |

—=
° =

Compass

SNZ15656

Cockpit

Behind the Wheel

Len 3 Current 130mA

| More Information | oK | | cancel |
—
GPS200 Properties b4
vic stanc - ok
Device Instance a ~ 1 | Lo
Device Label Compass Maretron |
)

Serial Number SN216733 = ——.al
Installation Description 1 Cabin roof
Installation Description 2 AB Installer, 12 Jan 2011

Len 2 Currant 100mA

| Cancel

| More Information |

Enter the values as shown and then
press OK.

Typically, when entering this information,
the serial number of the device is not
known. Leave this field blank, and
request the installer to write the number
on the printout. Then enter it back in the
file to keep your records in one place.

Next do the SSC200.

And the GPS200
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WSO0100 Properties x

Davice Instance o

@ [ Lock

Weather Station

Davice Label

Serial Number SNEE725622 ey

Installation Description 1 Masthead

Installation Description 2 AB Installer 17 January 2011

LEN 3 Current  150mA Conflgu red
Channel Paramaters
Source Type Data Instance Channel Label
Pressure Atmospheric ~| o Ij Masthead Pressure
Temperature | Outside ~| o Ij Masthead Temperature
Humnidity Outside v | o Ij Masthead Humidity |
wind 0 @ Masthead Wind
Cancel |

More Information | oK | L

Now we are ready to create the Network Configuration Table.

And the WSO100. The WSO100 has 4
channels, all of which need to be

Select Tools > Create Network Configuration Table to display a tabular report showing

details of each devices configuration.

Network Configuration Table
Metwork Configuration Table for
This file contains 1 network.
1. Network 1

Backbone contains only blue cables.

|

-

Model . Unique Installation Installation Descr.
Manuf. ID Serial No. Instance Source|| Label Descr. #1 #2
Maretron|DSM250 ||S16653GH |0 Helm Cockpit g‘gfl”“a”e“ 12 Jan
Cockpit - behind ||AB Installer, 12 Jan
Maretron||5SC200 |SN215656 0 Compass the wheel 2011
Maretron|GPS200 SN216733 || Compass |Cabin roof ’;glII”Sta”E“ 12 Jan
Maretron||\WS0100|SN88735622(0 weather |- sthead AB Installer 17
Station January 2011
| Channel | Source |[Instance| Label |
|Pressure ||Atmospheric||0 ||Ma5thead Pressure |
Create PDF File Close

T w—

The program N2KAnaIyzer® from Maretron® is typically used to do the programming of the
devices. The above table is exactly the same format as that used by N2KAnalyzer®, so all the

required information is readily available to the installer.

The Network Configuration Table may be exported as a PDF file. From there it may be printed

or emailed.
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7.10 Printing and Exporting the Drawings.

The contents of the Drawing Area may be printed and exported as either .jpg files or .png files
from the File menu.

Edit Tools About . . o o
e The Print function will print what is displayed on

Mew i . .

the screen. Zoom and pan as required to get the print
Open ' contents that you want.
Open Example
save e For exporting as either a jpg or png file, the full
SRR diagram is exported. Png files give better results than
e . jpg file. After exporting, they can be imported into an
Export Drawing to .png File application such as Paint, which will then allow them to
Print Drawing be printed as a set of tiles.
Cloze
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8 Tutorial 2 — Using the Single Ended Cordset

The Single Ended Cordset is designed to be used for the run up the mast. It is sold as a 25m
mid cable with a female molded connector to go at the top of the mast. The molded connectors
are smaller diameter than the field attachable connectors, and when connected to the Micro
Inline Termination Resistor will fit comfortably within the 1” pipe mount used to mount the
GPS100, GPS200, or WS0O100. The other end of the cable without a connector can be cabled
easily through small openings. A male field-attachable connector is required to connect the
Cordset to the network. Because of the length of the cable, the Single Ended Cordset is
intended to be used as part of the network backbone, not as a branch.

In the network designed in tutorial 1, select the cable going to the WSO100, then right click
and open the Cable Properties Dialog.

Cable Properties

() Double Ended Cordset () Single Ended Cordset (») Field Attachable Cable

(*) Mid () Micro

(») Blue () Grey

Cable Length inm 18

Cable Resistance 252mi

| | Male connectar has 90° bend

|| Female connector has 909 bend

| | Break power cable at Male Connector

| | Break power cable at Female Connector

Select the Single Ended Cordset option.
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Cable Properties

) Double Ended Cordset () Single Ended Cordset () Field Attachable Cable
(=) Mid

(#) Blue

Cable Length in m 18

Cable Resistance 242mE

L Male connector has 900 bend

| | Break power cable at Male Connector

IClnﬁel

Notice four things:

e The cable size has been restricted to Mid. The Single Ended Cordset is only available
as Mid cable. If the cable was originally a Mini cable, with Mini connectors, then the
option to change the cable type to a Single Ended Cordset would have been disabled.

e The cable color has been restricted to Blue. This cable is only available in Blue.

e The Cable Length has remained at 18m. Although the cable is sold in 25m lengths, it is
intended that the installer will cut the cable to an appropriate length to minimize voltage
drops. The maximum length that can be entered in this field is 25m.

e The options of the female connector have been removed. The female connector is
molded on to the cable, and cannot be changed.

Cabin

Mast On the diagram, the cable is now drawn with one molded
connector and one field attachable connector.

The field attachable connector is added to the BOM.

Page 42 Revision 1.7.0



Maretron

9 Tutorial 3 - More Complex Power Options

9.1 Multiple Power Sources
Using the techniques shown in Tutorial 1, create the following network using N2KBuilder®.

—

e 50 o]

EY nzKBuilder™
File Edit Tools About

Mini Cable Components Mid/Micra Cable Components Displays/Alarms Navigation Instruments

Design Rule Checks

 Jeminstors / Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables
Branches OK

« No Loops OK
 Power OK

-
 Number Nodes OK

« Cable Lengths OK
« Trunk Length oK

8.2volts 7.72Volts 7.4Volts 7.24Volts
« Branch Langth oK

(Cummative Branch
Length OK

 Currents OK
X voltages OK

« Common Mode
Voltages OK

Show On Drawing

Zoom In
Zoom Out
Zoom Extents
Dis; Details
Cable Lengths
Currents

Plug Gender
| Backbona(s)

10.66Volts

Maretron

Vamion £.3.30080720

2005 pae L ssne S

AEEENE]

Notes:
e All the trunk cables are 10m Mini overmolded cables.
e All the branch cables are 1m Micro overmolded cables
e All the Tees are Mini-Micro Tees.
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—

aﬂﬂj

EY N2KBuilder™
File Edit Tools About

Design Rule Checks Mini Cable Components Mid/Micra Cable Components Displays/Alarms Navigation Instruments

o Jerminatars / Engine,/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables
 No Loops OK

« Power oK
(Number Modes OK
 Cable Lengths OK
 Trunk Length OK
« Branch Length 0K

(Cumulatlve Branch
Length OK

B.2Vaolts 7.72Volts 7.4Volts 7.24\Valts

. . - ---- S - ---- [ - ---- . - - - - -
X voltages OK

Commen Mode
Voltages OK

Show On Drawing

Zoom In

Zoom Out
Zoom Extents
Dis; Details
Cable Lengths

Currents

Plug Gender
[ Backbona(s)

10.68Volts 10.66Valts

Maretron

Click the “Show on Drawing” button which will cause some of the DSM250 displays to be
highlighted in red. Because of the long cables and high current drain, the voltage drops across
the network are too large. We will fix the problem by adding a second PowerTap.

Delete the cable joining DSMs 2 and 3. Also delete the two cables to the left of the break. You
will notice immediately that the terminators glow, showing that the terminators are unmatched.

Add a second PowerTap as shown below.
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—~—

o [ ]

EY NZKBuilder™

File Edit Tools About
Design Rule Checls Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables Miscellaneous

J Terminatars Mid/Micro Cable Components Displays/Alarms Navigation Instruments
Branches OK

X o Loops OK I.ll I|.|',‘,' H ‘: =T ([ ‘;‘ e ‘;‘ JINIE ‘;‘ b H ‘;‘ .
. S ESD G ]
X number Nodas ok ] I =

X cabla Langths OK

X Trunk Length oK
X Branch Length OK

X Curnulstive Branch
Length OK

X currents 0K
X voltages oK

xcummun Mode
Voltages OK

Show On Drawing

8.2Volts 7.72Volts

Zoom In
— - -
Zoom Out 0Valts
Zoom Extents
Dis; Details
Cable Lengths
Currents

Plug Gender
[ Backbone(s)

10.66Valts

e Maretron

Vamion £.330030720

Sesum: ERS
- P, Cart € 2008 Maraton LU ko AR
Ched zae Com £ 3007 - 2008 Adss Sywtems ncmates MR
Aeprovc: ERS . £ s e 5
RS- = o s St 2o
mzvimen: ERS

Notice that the female connector from the PowerTap is facing the female connector of the Tee
to the left. Flip this Tee and the next Tee horizontally to correctly line up the sockets with the
correct genders.

Reconnect the cables. Set their lengths back to 10m.
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EY N2KBuilder™

|

File Edit Tools About

Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables Miscellaneous

Design Rule Checks

J Terminators / Mid/Micro Cable Components Displays/Alarms Navigation Instruments
(| Branches OK " s s . .
X No Loops 0K |.|. .|.|-;.' ' i [T - i e g i = — - = amlib=ml
L e I T =T (i) (=50 WD LT e T
— —

XNumber Modes OK I
X cable Lengths OK

iN[iR=NIN=N]

X Trunk Length OK
X Eranch Length OK

X Cumulstive Branch
Length OK

X Currents OK
X voltages OK

N X Common Mode
Voltages OK

l Show On Drawing

Zoom In
| Zoom Out
Zoom Extents
Dis; Details
Currents
Voltages

Plug Gender
Backbona(s)

Sraun: ERS
e ERS
Azgezud: ERS
ER— ERS

Now connect the last two Tees in the same way. N2KBuilder® will detect that both sockets are

female, and will use a Field Attachable Cable with two male connectors.
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EY NZKBuilder™
File Edit Tools About

==

Design Rule Checls Engine/Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables Miscellaneous

|/ Terminatars Mid/Micro Cable Components Displays/Alarms Navigation Instruments
Branches OK

 Power OK
« Number Nodas ok ] ]I
X cabla Langths OK

 Trunk Length oK
& Branch Length OK

 Curnulstive Branch
Length OK

 Currents 0K
« voltages oK

M  Common Mode
Voltages OK

l Show On Drawing

Zoom In
Zoom Out
Zoom Extents
Dis; Details
Currents

Voltages

Plug Gender
Backbone(s)

Sesum: ERS
- P, Cart € 2008 Maraton LU ko AR
Ched zae Com £ 3007 - 2008 Adss Sywtems ncmates MR
Aeprovc: ERS . £ s e 5
RS- = o s St 2o
mzvimen: ERS

Open the Cable Properties Dialog for the Cable, and set the length to 10m. We also choose to
break the Power Cables at both ends of this cable so that the power on each half of the
network is isolated from the other half.

Cable Properties

(_) Single Ended Cordset (s) Field Attachable Cable

2/
| (=) Mini () Mid () Micro

| Blue (=) Gray

Ly WL

Cable Length in m i0

Cable Resistance 11EZma

u |¥] Bresk power cable at First Connector

|\|_(| Break power cable at Second Connector

Close
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The result is shown on the drawing as follows:

Our design now passes the Design Rule Checks.

9.2 Voltage Drops to the PowerTap.

Using the previous design, display the voltages on the drawing by clicking on the Voltages
button.

11.05Vaits Two voltages are shown for each Mini PowerTap.

The voltage associated with the yellow power cable (12V) is the voltage
at the source.

The voltage above the Mini PowerTap (11.08V) is the voltage that is
supplied to the bus, taking into account the losses in the yellow power
cable and in the Mini PowerTap.

Open the Properties Dialog for the Mini PowerTap.
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Mini Powertap Properties x

Include Power Cable

) None |_J) One Metre (s Five Metres

Supply Voltage 12 Volts

Power Cable Feed Length |5 m %
el
[

[ oK | | Cancel |

bl v - v

The Power Cable is supplied in one of two lengths, 1m or 5m. The top selection is used to
choose which option is included in the BOM.

To reduce voltage drops, this cable may be cut to length during installation, or even
lengthened. If it is lengthened, the Design Rule Checker will assume that the cable used for
the extension has similar characteristics as the supplied yellow cable (i.e. 16AWG and 13mQ /
m)

The total length of the cable from the source to the PowerTap should be entered in the Power
Cable Feed Length box.

Change the Included Power Cable to 1m. The Power Cable Feed Length changes to 1m to
match. Click OK.

The voltage to the network has risen by 0.2V.

11 23 0=
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10 Tutorial 4 - Extending an Existing Network

Using the design from Tutorial 3, we will add two Tank Level Monitors so that we can see the
levels of the fuel tanks. These are the TLM100 devices from the Engine/Vessel Monitoring tab.

Open the file from Tutorial 3, and exclude the entire design from being in the BOM.

[ E! M2KBuillder™ - tutornal 3.n2b
File Edit | Tools | About
T Create Bill Of Materials Report
Eﬂnmciﬁ Create Design Rules Check Report
¢ No Loo Create Design Report ﬁ
¥ Power ¢ Create Metwork Configuration Table
¥ Numbe Include All Within in BOM
v Cable | Exclude All From BOM i
o Trunk | Snap all Cables / Lines
o Rranch IEAAtR R ———————

The result is that all the components are given faded colors to show that they will be excluded
from the BOM in future.
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‘l N2KBuilder™ - tutorial 3.n2

[ File Edit Tools About

I Frcrmfremens | Engine/Vessel Monitoring | Gateways/Tools | Adaptors/Adapter Cables Miscellaneous

/ Terminators / Mid f Micro Cable Components Displays/Alarms Navigation Instruments
Branches OK

 No Loops 0K 0 i i i .II .II

+ Power OK I

I = o

o Number Nodes OK i = II.I..‘ .I .I

 Cable Langths OK

 Trunk Length OK

10.23Valts 10.49Valts 10.78Valts 10.62Valts

+ Branch Length OK
(Cumulat\'ve Branch
Length DK
(Cumams oK
= = =
= =
] i
5 f ol
A=

o veoltages oK 5;'
2

 Common Made
Voltages OK

HZVDHS
Show On Drawing
]

i = ) 0 o o g o Fa - P .
— R T f.n.un.m S,
Break Power'Cable o o D D

Zoom Out 10.91Valts
Zoom Extents
10.49Valts 10.65Valts 11.08Volts

R D D i _ jio r:u‘fﬂ[['ﬂ_] r:u‘fﬂ[['ﬂ

o)
HHH]

=
i
S

]
i
]

[t
oD

o)
HHE]

[Tt

[

] 1T

e

pr—
Currents = = "|:|i' 53 i

y v T T

Plug Gender od od

5 x =] =]

Show Handles = = &= =3

L_ShowHandie- | 25 23 £ 23

i Backbona(s) = =
H T T T T "

AT T [ = -

11.03Volks

Break Power'@able 11.02Volts

Maretron

i
Bl R

Drag two TLM100 devices and a Multiport Box from the Mid/Micro Cable Components tab. Flip
the Multipoint Box horizontally to give the following result.
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E M2KBuilder™ - tutorial 3.n2b

File Edit Tools About

Desiqn Rule Checks Engine/Vessel Monitoring I Gateways/Tools | Adaptors/Adapter Cables I Miscellaneous
/ Terminators / Mini Cable Components Displays/ Alarms Navigation Instruments
Branches OK

" No Loops 0K
 Pover OK
 Number Hodes OK
« Cable Lengths OK

o Trunk Length OK

« Branch Length oK
 Cumulative Branch
Length OK

 Currents OK
= =
53 Bd
g3 '
A= k=

 voltages oK

 Common Mode
Voltages OK

—

Show On Drawing = =

o
3 &

=

1

Break Power'@able

Zoom OQut
Zoom Extents

D_:ﬁ,— “':*;" D D [_'[l_'l][[J]_'J r;[[_‘l][[ 10
= < il Y

]

Currents
Voltages

Plug Gender
Show Handles
Backbone(s)

—

| Zoomin .][['H.J L‘IL'.’I][['JI'J r:u:l][[ﬂ.u c:u’jl] )

(L]

i

q

b

i

Maretron

oats: s © 20 - e
— zate:
1. e ssssap ans g
Eadeaca o mgted Eaderac b o Uted e 4
ﬂ E— zate:

Now select and drag the terminator to the right.

A cable will appear to keep the connection.
D I:J]_'I]]E;g-:E[I]'_H'.: ull

Mini Termination Resistor with LE
=

@ Add another Mini/Micro Tee
o

Delete the Cable.

the backbone.

Add Micro Cables to complete the design as follows.

Drag the terminator back to connect to the new Tee and complete
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‘l N2KBuilder™ - tutorial 3.n2b

File Edit Tools About

Desiqn Rule Checks Engine/Vessel Monitoring I Gateways/Tools | Adaptors/Adapter Cables J Miscellaneous

VTR

" No Loops 0K
 Pover OK
 Number Hodes OK
X Cable Lengths OK
o Trunk Length OK =

« Branch Length oK
Cumulative Branch
o S Brane
 Currents OK
= =
&7 &7
g g
k= k=

 voltages oK

== ==
I !
24 23
 Common Mode =1 =]
Valtages oK
Show On Drawing = (ﬂ\ £
2L i 2d
= = =

il . . . __d - x . » .
zoomi 1 e 1 1T e T RN L DT T 15
S— e Pzl

Zoom Extents
Dt bt D D LT T m';uu%:n[r_m
Currents g g o '

Voltages = =

Plug Gender
Show Handles £

&
l Backbone(s) =
W [T EHIUDE%ED[['JI’J
Break Power'@shble

A
nnnl | linan)

s Maretron

o ot £ 2007 - 20 hdsen Tosawad MR
o e sssoap 1 g 15w wae
S e— w4

il

Set the cable lengths to 2m each.

Before we are complete, we do need to characterize the TLM100 devices. Open the TLM100
Properties Dialog.
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TLM100 Properties x

Device Instance o

=

Device Label

Serial Number

Installation Description 1

Installation Description 2

Llem 2 Current 100mA
Tank Details
Tank Type (=) 40" Depth Tank |_J 24" Depth Gasoline Tank _) 104" Depth Tank
Mounting | SAE 11810 5-hole mounting v |
Channel Parameters
Source | ¥ | Data Instance O [ : | Data Label

Optional Accessories

Mumber of optional Focus Tubes o [ : |

Mumber of optional Black Water Airlocks o [ : |

oK | | Cancel |

More Information | |
- |

Change the mounting to a 1.5” NPT threaded opening. This mounting requires a special
adapter, and so the Properties Dialog will suggest that you order this adapter as well.

Set the Device Label to “Port Tank”, and the Device Instance to “0”. As this is a tank for diesel,
also set the Channel Parameters to “Fuel”, the Data Instance to “0” and the Data Label to “Port
Diesel Tank”. We will also order a Focus Tube for the tank.

Planning these details early will help the installer, and provide a record of the details of the
design. The label of each device will be shown in the Tool Tip text displayed when the mouse
hovers over the device in the Drawing Area.
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TLM100 Properties

Device Instance o] lil

Davice Label Port Tank

Serial Number

Installation Description 1

Installation Description 2

Tank Details
Tank Type (=) 40" Depth Tank

Mounting | 1.5" NPT threaded opening

Current

N

100maA

|_) 24" Dapth Gasoline Tank ) 104" Depth Tank

The mounting that you have chosen requires an optional Mounting Adapter. Please ensure that at least

one Adapter is selected below.

Number of optional Mounting Adapters 1 [ : |
Channel Parameters

Source | Fuel ¥ | Dats Instance O

Optional Accessories

Number of optional Focus Tubes

Number of optional Black Water Airlocks

Maore Information |

Ty

i : EEIERELEN POt Diesal Tank

0K Cancel |

Set up the starboard tank in the same way, with a 1.5” NPT threaded mounting, a Device Label
of “Starboard Tank”, and a Device Instance of “1”. Set the Channel Parameters to “Fuel”, the
Data Instance to “1” and the Data Label to “Starboard Diesel Tank”. We will also order a Focus

Tube for the tank.
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If we now generate the BOM, we will see that only the new components are on the page.

' Bill of Material Report

Manufacturer Part Number
Maretron CM-CF-4
Maretron CM-CG1-CF-02.0
Maretron NM-CF-NF
Maretron TA-5H-1.5NPT
Maretron TFT-1.5NPT
Maretron TLM1i00-01

1

|

| Create CSV File | | Create PDF File

Description

Multiport Box (Micro-Mid M Homerun/ Micro-Mid F Drops)
Micro Double Ended Cordset - M to F - 2.0m Gray
Mini/Micro Tee

1.5" NPT Displacement Hull Tank Adapter

1.5" NPT Mon-Displacement Hull Focus Tube

Tank Leval Monitor (40")

Print |

Quantity

Close
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11 Tutorial 5 - Creating Other Devices

Devices that are not pre-populated in the Component Library Area may be added to the
design.

e They will be included in all the Design Rule Checks
o They will appear on the diagram.
e They will not be included in the BOM.

From the Miscellaneous tab, select the Generic Device.

Mini Cable Components Mid f Micro Cable Components Displays/Alarms Navigation Instruments

Engine {Vessel Monitoring Gateways/Tools Adaptors/Adapter Cables

The Generic Device is initially shown with “?”.
Place the device on the Drawing Area, and open the Properties Dialog.

GenericDevice Properties x

Manufacturer 7

Name ?

LEN O Current | 0 mA

I oK J I Cancel I

The Manufacturer and Name are two string fields that can be set to any value by the user. The
name will be displayed in the center of the device when displayed in the drawing area, and in
reports.

The LEN and Current Fields are dependent on each other. The values entered are critical to
the accuracy of the Design Rule Checker. Always enter the maximum values. Changing one of
these values will cause the other to be updated when the cursor is moved to another field.

Set the name to “Gizmo” and the LEN to 3 (150mA). Attach the device to a backbone, show
the currents on the drawing and you will see the following:
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0.15Amps

0.15Amps
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12 Tutorial 6 — Working with Pictures

Pictures may be used to add interest to a design.

e Pictures may be .jpg files or .png files, and may contain Logos, Boat Drawings or any
type of Image.

o They will appear on the diagram.

e They will not be included in the BOM.

From the Miscellaneous tab, select the Picture.

Mini Cable Components Mid f Micro Cable Components Displays/Alarms Navigation Instruments
Engine/Vessel Monitoring Gateways/Tools

Place the Picture on the Drawing Area, select it, and open the Properties Dialog.

Picture Properties =
Filaname Browse
width &0 Height 40 Scala
oK Cancel

Browse to the N2KBuilder install directory (typically C:\Program Files\N2KBuilder\images) and
select the Maretron-Logo-400x75.jpg file. This image is 400 pixels wide by 75 pixels high, and
we decide that our displayed picture will be twice this size. Set the Width to 800 and the Height
to 150.

If you are unsure of what dimensions to enter, the preview area within the Dialog will show how
the picture fits in to the box size that you have chosen. So, experiment a bit to find the
dimensions that suit your graphic.
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Picture Properties x

Maratran:

K| I el |
Press OK to save the Picture, and see the result on
the drawing area.

Filename Ci\Program Files\NZKBuilderi | Browse

Width 200 Height 150 Scala

oK | | Cancel |
Picture Properties x

Maretron

If the size needs tweaking, go back into the Picture
Properties Dialog and change the Width and the
Height.

Here we see the result of having a height that is too
large. The image occupies only the top of the box.

Filename Ci\Program Files\NZKBuilder\i | Browse
width | 800 Height | s00| Scale

oK Cancel
| ) | )

Note: The picture file (.jpg or .png) will NOT be saved within the design file (.n2b). Only the
relative path and filename to the graphic file is saved. If the design file is moved to another
directory (or emailed to another computer) the picture file must be moved (or emailed) as well.

It is suggested that all picture files are stored in the same directory as the design file. When
emailing, zip up the entire directory and then unzip all the files on the destination computer.
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If the link to the picture is incorrect, the following will be shown on the display area.

%

Clicking anywhere within the border will select the Picture, which can then be edited and the
correct picture file chosen.
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13 Technical Support

If you require technical support for Maretron products, you can reach us in any of the following
ways:
Telephone: 1-866-550-9100
Fax: 1-602-861-1777
E-mail:  support@maretron.com
World Wide Web:  http://www.maretron.com
Mail: Maretron, LLP
Attn: Technical Support
9014 N. 23" Ave Suite 10
Phoenix, AZ 85021 USA
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